
 2015 Microchip Technology Inc. DS50002380A

PMBus™ Monitoring
Graphical User Interface

User’s Guide



DS50002380A-page 2  2015 Microchip Technology Inc.

Information contained in this publication regarding device
applications and the like is provided only for your convenience
and may be superseded by updates. It is your responsibility to
ensure that your application meets with your specifications.
MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR
IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION,
INCLUDING BUT NOT LIMITED TO ITS CONDITION,
QUALITY, PERFORMANCE, MERCHANTABILITY OR
FITNESS FOR PURPOSE. Microchip disclaims all liability
arising from this information and its use. Use of Microchip
devices in life support and/or safety applications is entirely at
the buyer’s risk, and the buyer agrees to defend, indemnify and
hold harmless Microchip from any and all damages, claims,
suits, or expenses resulting from such use. No licenses are
conveyed, implicitly or otherwise, under any Microchip
intellectual property rights unless otherwise stated.

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.

• Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the 
intended manner and under normal conditions.

• There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our 
knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data 
Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 
mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Microchip received ISO/TS-16949:2009 certification for its worldwide 
headquarters, design and wafer fabrication facilities in Chandler and 
Tempe, Arizona; Gresham, Oregon and design centers in California 
and India. The Company’s quality system processes and procedures 
are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping 
devices, Serial EEPROMs, microperipherals, nonvolatile memory and 
analog products. In addition, Microchip’s quality system for the design 
and manufacture of development systems is ISO 9001:2000 certified.

QUALITY MANAGEMENT  SYSTEM 
CERTIFIED BY DNV 

== ISO/TS 16949 == 

Trademarks

The Microchip name and logo, the Microchip logo, dsPIC, 
FlashFlex, flexPWR, JukeBlox, KEELOQ, KEELOQ logo, Kleer, 
LANCheck, MediaLB, MOST, MOST logo, MPLAB, 
OptoLyzer, PIC, PICSTART, PIC32 logo, RightTouch, SpyNIC, 
SST, SST Logo, SuperFlash and UNI/O are registered 
trademarks of Microchip Technology Incorporated in the 
U.S.A. and other countries.

The Embedded Control Solutions Company and mTouch are 
registered trademarks of Microchip Technology Incorporated 
in the U.S.A.

Analog-for-the-Digital Age, BodyCom, chipKIT, chipKIT logo, 
CodeGuard, dsPICDEM, dsPICDEM.net, ECAN, In-Circuit 
Serial Programming, ICSP, Inter-Chip Connectivity, KleerNet, 
KleerNet logo, MiWi, MPASM, MPF, MPLAB Certified logo, 
MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient Code 
Generation, PICDEM, PICDEM.net, PICkit, PICtail, 
RightTouch logo, REAL ICE, SQI, Serial Quad I/O, Total 
Endurance, TSHARC, USBCheck, VariSense, ViewSpan, 
WiperLock, Wireless DNA, and ZENA are trademarks of 
Microchip Technology Incorporated in the U.S.A. and other 
countries.

SQTP is a service mark of Microchip Technology Incorporated 
in the U.S.A.

Silicon Storage Technology is a registered trademark of 
Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology 
Germany II GmbH & Co. KG, a subsidiary of Microchip 
Technology Inc., in other countries. 

All other trademarks mentioned herein are property of their 
respective companies.

© 2015, Microchip Technology Incorporated, Printed in the 
U.S.A., All Rights Reserved. 

ISBN: 978-1-63277-671-6



Object of Declaration: PMBus™ Monitoring Graphical User Interface
 2015 Microchip Technology Inc. DS50002380A-page 3



PMBus™ Monitoring Graphical User Interface User’s Guide
NOTES:
DS50002380A-page 4  2015 Microchip Technology Inc.



PMBus™ MONITORING
GRAPHICAL USER INTERFACE
USER’S GUIDE

Table of Contents
Preface ........................................................................................................................... 7
Introduction............................................................................................................ 7

Document Layout .................................................................................................. 7

Conventions Used in This Guide........................................................................... 8

Warranty Registration............................................................................................ 8

Recommended Reading........................................................................................ 9

The Microchip Web Site ........................................................................................ 9

Development Systems Customer Change Notification Service .......................... 10

Customer Support ............................................................................................... 10

Document Revision History ................................................................................. 10

Chapter 1. Product Overview
1.1 Introduction.................................................................................................... 11

1.2 The Development System’s Components ..................................................... 11

Chapter 2. Installation and Operation
2.1 Getting Started .............................................................................................. 13

2.1.1 Required Software...................................................................................... 13

2.1.2 Required Hardware .................................................................................... 13

2.2 Graphical User Interface Installation ............................................................. 14

2.3 Driver Installation for the Adapter.................................................................. 20

2.4 PMBMonitor Software Uninstall..................................................................... 23

Chapter 3. Graphical User Interface Description
3.1 Introduction.................................................................................................... 27

3.2 The Graphical User Interface ........................................................................ 28

3.2.1 Menu Bar.................................................................................................... 28

3.2.2 Connection Bar........................................................................................... 28

3.2.3 Status Bar................................................................................................... 29

3.2.4 LOG Text Box............................................................................................. 29

3.2.5 Clear Log Button ........................................................................................ 29

3.2.6 Status Menu ............................................................................................... 30

3.2.7 Basic Settings Menu................................................................................... 33

3.2.8 Advanced Settings Menu ........................................................................... 35

3.2.9 Statistics Menu .......................................................................................... 37

3.2.10 Alarms Details Menu ................................................................................ 38

3.2.11 About Menu .............................................................................................. 39
 2015 Microchip Technology Inc. DS50002380A-page 5



PMBus™ Monitoring Graphical User Interface User’s Guide
3.2.12 Help Menu.................................................................................................39

3.2.13 Developer Menu........................................................................................40

Chapter 4. Using the PMBus Graphical User Interface.............................................45

Worldwide Sales and Service .....................................................................................52
DS50002380A-page 6  2015 Microchip Technology Inc.



PMBus™ MONITORING
GRAPHICAL USER INTERFACE
USER’S GUIDE

Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
PMBus™ Monitoring Graphical User Interface. Items discussed in this chapter include:

• Document Layout

• Conventions Used in This Guide

• Warranty Registration

• Recommended Reading

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the PMBus™ Monitoring Graphical User Interface 
as a development tool to emulate and debug firmware on a target board. The manual 
layout is as follows:

• Chapter 1. “Product Overview” – Contains important information about the 
PMBus™ Monitoring Graphical User Interface

• Chapter 2. “Installation and Operation” – Covers the initial setup of the 
PMBus™ Monitoring Graphical User Interface

• Chapter 3. “Graphical User Interface Description” – Describes the Graphical 
User Interface

• Chapter 4. “Using the PMBus Graphical User Interface” – Covers the 
operation of the PMBus™ Monitoring Graphical User Interface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2015 Microchip Technology Inc. DS50002380A-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending in the Warranty Registration Card entitles users to receive new product 
updates. Interim software releases are available at the Microchip web site.

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS50002380A-page 8  2015 Microchip Technology Inc.



Preface
RECOMMENDED READING

This user’s guide describes how to use the PMBus™ Monitoring Graphical User 
Interface. Other useful documents are listed below. The following Microchip documents 
are available and recommended as supplemental reference resources:

MCP19110/11 Data Sheet (DS20002331)

This data sheet describes the operation and features of the MCP19110/11 
digitally-enhanced power analog controller with integrated synchronous driver.

MCP19111 PMBus™ Protocol-Enabled Point-of-Load (POL) Converter 
Reference Design User’s Guide (DS50002379)

This user’s guide describes how to use the MCP19111 PMBus protocol-enabled POL 
converter reference design.

TB3139, MCP19111 PMBus™ Firmware Technical Brief (DS90003139)

This technical brief describes how to use the MCP19111 PMBus firmware.

MCP2221 Breakout Module User’s Guide (DS50002282)

This technical brief describes how to use the MCP19111 PMBus firmware.

PMBus Specification

This specification can be found at: http://www.pmbus.org.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives
 2015 Microchip Technology Inc. DS50002380A-page 9
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DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB® C compilers; all MPLAB 
assemblers (including MPASM™ Assembler); all MPLAB linkers (including 
MPLINK™ Object Linker); and all MPLAB librarians (including MPLIB™ Object 
Librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 In-Circuit Emulators.

• In-Circuit Debuggers – The latest information on Microchip in-circuit debuggers. 
This includes MPLAB ICD 3 In-Circuit Debugger and PICkit™ 3 Debug Express.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM Simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers, such as MPLAB REAL ICE In-Circuit Emulator, MPLAB 
ICD 3 In-Circuit Debugger and MPLAB PM3 Device Programmer. 

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revision A (August 2015)

• Initial Release of this Document.
DS50002380A-page 10  2015 Microchip Technology Inc.
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Chapter 1.  Product Overview
1.1 INTRODUCTION

The PMBus™ Monitoring Graphical User Interface (PMBMonitor GUI) is a universal 
user interface that can be used with any device that has a Power Management Bus 
(PMBus) protocol incorporated. For the purpose of this user’s guide, the MCP19111 
PMBus™ Protocol-Enabled POL Converter Reference Design board (ARD00609) has 
been used.

1.2 THE DEVELOPMENT SYSTEM’S COMPONENTS

To use the GUI, the following tools are required:

• PMBus™ Monitoring Graphical User Interface: This Graphical User Interface 
allows monitoring and changing input and output parameters for any device that 
has a PMBus protocol incorporated.

• PICkit™ Serial Analyzer: PICkit is recommended as a communication tool to 
configure the board; it is available for purchase on microchipDIRECT.

• MCP2221 Breakout Module (ADM00559): This board is available from Microchip 
and provides a method to evaluate/demonstrate the capabilities of the PMBus™ 
Monitoring Graphical User Interface. This device allows I/O control and custom 
device configuration. The MCP222X device can be incorporated on board 
(e.g., evaluation board).

In order to connect the GUI to the device, a PICkit Serial Analyzer or an MCP2221 
Breakout Module must be used, as described in Chapter 2. “Installation and 
Operation”. If the device has standard PMBus commands implemented, the interface 
can collect basic data from the device. Values, such as the output voltage, the input 
voltage, the output current, the temperature, as well as the corresponding thresholds, 
can be modified using the PMBus™ Monitoring Graphical User Interface. The time 
evolution of the output and input voltage, output current and temperature can be 
analyzed using the graphs provided by the interface.
 2015 Microchip Technology Inc. DS50002380A-page 11



PMBus™ Monitoring Graphical User Interface User’s Guide
NOTES:
DS50002380A-page 12  2015 Microchip Technology Inc.



PMBus™ MONITORING
GRAPHICAL USER INTERFACE
USER’S GUIDE

Chapter 2.  Installation and Operation
2.1 GETTING STARTED

In order to install, use and evaluate the product, there are several software and 
hardware tools required to be installed and/or set.

2.1.1 Required Software

• PMBus Monitoring GUI (v.1.0)

• Microsoft® .NET Framework 4.5 or Higher

• Adobe® Reader

• Windows® 7

2.1.2 Required Hardware

2.1.2.1 CONNECTED BOARDS

• MCP19111 PMBus™ Protocol-Enabled POL Converter Reference Design 
(ARD00609) 

or
• Any board that supports the PMBus protocol

2.1.2.2 COMMUNICATION TOOLS

• PICkit™ Serial Analyzer, Firmware Revision 0x0305 or newer 
or

• MCP2221 Breakout Module

NOTICE

The PMBus™ Monitoring Graphical User Interface must be used with the MCP19111 
PMBus™ Protocol-Enabled POL Converter Reference Design board (ARD00609), or any 
other board with the PMBus protocol implemented, connected to the PC. Otherwise, the 
PMBus™ Monitoring Graphical User Interface will not be completely functional.

Note: The board connected to the PC might have the adapter incorporated. In this 
case, no other adapter is required, only a USB cable is needed. Please 
refer to the board user’s guide.
 2015 Microchip Technology Inc. DS50002380A-page 13
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2.2 GRAPHICAL USER INTERFACE INSTALLATION

The following steps describe how to install the PMBus™ Monitoring Graphical User 
Interface.

1. If Microsoft .NET Framework is already installed, go to Step 3. If not, download 
Microsoft .NET Framework from www.microsoft.com and follow the installation 
instructions.

2. If Adobe Reader is already installed, go to Step 3. If not, download Adobe Reader 
from http://get.adobe.com/reader/ and follow the installation instructions.

3. Download the PMBus Monitoring GUI (v.1.0) archive from 
www.microchip.com/mcp19111, under “Documentation & Software”.

4. Unzip the PMBus Monitoring GUI (v.1.0) archive, which contains the setup.exe 
file.

5. Double click on the setup.exe file to open the InstallShield Wizard window and 
wait for the extraction to complete. If required, the installation can be stopped by 
pressing the Cancel button.

FIGURE 2-1: Preparing the InstallShield Wizard for the PMBMonitor.

Note: If an older version or a corrupted version of the current PMBMonitor is 
already installed on the computer, please see Section 2.4 “PMBMonitor 
Software Uninstall” before proceeding with the installation.
DS50002380A-page 14  2015 Microchip Technology Inc.
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6. In the Welcome to the InstallShield Wizard for PMBMonitor window, click on the 
Next button to start the installation. 

FIGURE 2-2: Starting the PMBMonitor Installation.

7. Review and accept the License Agreement by checking the I accept the terms 
in the license agreement option button, then click on the Next button.

FIGURE 2-3: The License Agreement Window.
 2015 Microchip Technology Inc. DS50002380A-page 15
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8. The installation path can be changed, although it is recommended to keep the 
default path. Click on the Next button to continue.

FIGURE 2-4: Selecting the Destination Folder.
DS50002380A-page 16  2015 Microchip Technology Inc.



Installation and Operation
9. In the Ready to Install the Program window, click on the Install button and wait 
for the application to proceed with the installation. The progress can be observed 
in the “Status” bar.

FIGURE 2-5: Installing the PMBMonitor.
 2015 Microchip Technology Inc. DS50002380A-page 17
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10. Once the installation completes, leave the Launch the program box checked to 
automatically start the PMBMonitor user interface or deselect this check box to 
start the GUI at a later stage. Click Finish to end the installation.

To start the GUI at a later stage, either click on the desktop icon or browse to 
Windows Start>All Programs>Microchip>PMBMonitor.

FIGURE 2-6: The Installation Complete Window.
DS50002380A-page 18  2015 Microchip Technology Inc.
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11.  The interface will display the Status menu and the scan address function will be 
active.

FIGURE 2-7: Initial Status Menu.
 2015 Microchip Technology Inc. DS50002380A-page 19
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2.3 DRIVER INSTALLATION FOR THE ADAPTER

If the USB integrated on the board or a separated MCP2221 Breakout Module is used, 
install the appropriate driver after installing the GUI. 

The following steps describe the installation process.

1. Go to Windows Start>Control Panel>System and Security. Choose System from 
the right panel and click Device Manager from the left pane to open the list of 
installed hardware. In the “Other devices” list, identify a USB unknown 
connection. 

Right click on the unknown driver and click on “Update Driver Software”.

FIGURE 2-8: Device Manager – Update Driver.

2. In the Update Driver Software window, click on “Browse my computer for driver 
software” option.

FIGURE 2-9: Browse Computer for Driver.
DS50002380A-page 20  2015 Microchip Technology Inc.
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3. Click on the Browse button and select the path where the GUI was installed. 
If the path was left unchanged, go to the 
C:\Program Files (x86)\Microchip\PMBMonitorGUI folder and click 
the OK button.

Click Next to start the driver installation.

FIGURE 2-10: Selecting the Path.

FIGURE 2-11: Installing the Driver Software.
 2015 Microchip Technology Inc. DS50002380A-page 21
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4. If the following warning message pops up, select the “Install this driver anyway” 
option; otherwise, skip this step.

FIGURE 2-12: Warning Message.

If the driver was successfully installed, the following window pops up:

FIGURE 2-13: Installation Successful.

After installation, the device should be recognized in the Device Manager; otherwise, 
remove and plug in the USB cable again.

FIGURE 2-14: USB Recognized.
DS50002380A-page 22  2015 Microchip Technology Inc.
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2.4 PMBMonitor SOFTWARE UNINSTALL

In order to install the current PMBMonitor version, any previous version or corrupted 
version of the current one should be removed from the computer.

If there is an older version installed on the computer, the message box from Figure 2-15 
will be displayed in Step 5 of the installation process. Uninstall the older version from 
Windows Start>Control Panel>Programs>Uninstall a Program, then go to Step 5 to 
resume the installation.

FIGURE 2-15: Windows® Installer Message Box.

If the current PMBMonitor version is already installed on the computer, but it is 
corrupted, the message box in Figure 2-16 will be displayed in Step 6 of the installation 
process. In this case, the following steps should be followed to uninstall the current 
version of the PMBMonitor:

1. Select the Remove option button, then click the Next button.

FIGURE 2-16: The Program Maintenance Window.
 2015 Microchip Technology Inc. DS50002380A-page 23
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2. In the Remove the Program window, click the Remove button to remove the 
current PMBMonitor version from the computer.

FIGURE 2-17: Removing Previous Installations.
DS50002380A-page 24  2015 Microchip Technology Inc.



Installation and Operation
3. When the PMBMonitor completes the uninstall process, click on the Finish 
button, then go to Step 5 to resume the installation of the PMBMonitor GUI.

FIGURE 2-18: Uninstalling the PMBMonitor.
 2015 Microchip Technology Inc. DS50002380A-page 25
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Chapter 3.  Graphical User Interface Description
3.1 INTRODUCTION

This chapter describes how to use the GUI and the PMBus™ protocol device 
characteristics that are included and monitored.

FIGURE 3-1: Graphical User Interface – Initial Screen.

Menu Bar Connection Bar

LOG
Text Box

Progress
Bar

Status
Bar

Clear Log
Button

Note: If the commands are not implemented for the connected device, the “Err” message will be 
displayed in the corresponding fields.
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3.2 THE GRAPHICAL USER INTERFACE

The following sections describe the items in the Graphical User Interface.

3.2.1 Menu Bar

The menu bar contains the items available for the user to display the device’s 
characteristics and settings, as shown in Table 3-1.

FIGURE 3-2: Menu Bar.

3.2.2 Connection Bar

The connection bar contains the items in Table 3-2.

FIGURE 3-3: Connection Bar.

TABLE 3-1: MENU BAR ITEMS

Item Description

Status Displays the Status menu.

Basic Settings Displays the Basic Settings menu.

Advanced Settings Displays the Advanced Settings menu.

Statistics Displays the Statistics menu.

Alarms Details Displays the Alarms Details menu.

About Shows information about the version of the product.

Help Opens a PDF document with details on the PMBus™ Monitoring Graphical User Interface.

Developer Displays the Developer menu. This menu is only available for Microchip PMBus 
protocol-enabled devices.

TABLE 3-2: CONNECTION BAR ITEMS

Item Description

Addr This drop-down menu shows the address of the PMBus™ protocol device.

Connector This drop-down menu shows the type of connector used to connect the board to the PC. The 
connector is automatically recognized. Connect the MCP19111 board to the PC by 
connecting a PICkit™ Serial Analyzer (PICkitSA) to the I2C connector on the board. 
Alternatively, connect to the PC using the USB port on the MCP19111 board. In this case, the 
MCP222X integrated in the MCP19111 board is used to perform the communication.

ScanAddr This button is used to scan for PMBus protocol devices connected to the PC.

Connect/Disconnect These buttons are used to connect/disconnect the PMBus protocol device. (Note 1)

Voltage This drop-down menu is used to select the voltage level of the I2C communication interface. 
(Note 2)

Rate This drop-down menu is used to select the corresponding communication rate for the device.

Pullups This drop-down menu is only available when the PICkitSA connector is used and allows 
enabling/disabling the PICkit pull-ups.

Note 1: The Disconnect button is disabled when the ScanAddr and Connect buttons are enabled, and enabled 
when the ScanAddr and Connect buttons are disabled.

2: When using the MCP2221 Breakout Module, the voltage can be set by hardware (the jumpers on the 
board).
DS50002380A-page 28  2015 Microchip Technology Inc.
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3.2.3 Status Bar

The status bar provides information on the status of the device connected to the PC. 
This bar is available in all menus.

FIGURE 3-4: The Status Bar.

The items available in the status bar are shown in Table 3-3.

3.2.4 LOG Text Box

This text box is used to display messages from the PMBus communication. It is 
updated after each command and it gathers all information if the “Verbose Log” check 
box in the Status menu is selected, and until the Clear Log button is pressed. If the 
“Verbose Log” check box is not selected, the “LOG” text box will be updated only after 
the values have been sent on the PMBus protocol and the parameter values have been 
written.

The LOG text box is available in the Status, Basic Settings, Advanced Settings, 
Statistics and Developer menus.

3.2.5 Clear Log Button

This button deletes all messages shown in the “LOG” text box, up to the time when the 
button has been pressed.

The Clear Log button is available in the Status, Basic Settings, Advanced Settings, 
Statistics and Developer menus.

Status Indicator

Status Label

Code Label

TABLE 3-3: STATUS BAR ITEMS

Item Description

Status 
Indicator

The status indicator turns red if there is no device connected to the PC. Otherwise, this indicator turns 
green.

Status Label The status label on the bottom of the GUI shows if there is any device connected to the board. Refer 
to Table 3-4 for a list of the possible labels.

Code Label If an MCP19111 board is connected, this label shows the firmware version. For devices that do not 
implement this specific command, this label shows “N/A:N/A”.

TABLE 3-4: STATUS LABELS

Status Label Description

STATUS: searching for device... This message is shown when opening the GUI, before scanning the address of the 
device.

STATUS: Connected! This message is shown when the GUI detects a device connected to the board.

STATUS: Disconnected! This message is shown when the GUI does not detect any device connected to the 
board.
 2015 Microchip Technology Inc. DS50002380A-page 29
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3.2.6 Status Menu

The Status menu is the first tab displayed when opening the PMBMonitor.

FIGURE 3-5: Initial Status Menu.

The Status menu is only used to monitor the PMBus device parameters, to 
enable/disable the converter and to store/restore values. The items found in the Status 
menu are shown in Table 3-5.
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BLE 3-5: STATUS MENU ITEMS

Panel Item Description

TATUS VIN Shows the input voltage value.

VOUT Shows the output voltage value.

IOUT Shows the output current value.

TEMP Shows the temperature value. Use the C and F radio buttons to choose the type of degre
Fahrenheit.

LARMS Overcurrent Shows the overcurrent Fault limit. The green alarm on the left will turn red when the IOUT
overcurrent warning/Fault limit. The overcurrent warning limit is lower than the overcurren
or greater than the overcurrent warning/Fault limit value, the red alarm turns on and stays
is sent from the Alarms Details menu.

Output
Undervoltage

Shows the output undervoltage Fault limit. The green alarm on the left will turn red when 
the output undervoltage warning/Fault limit. The output undervoltage warning limit is grea
limit. If the VOUT value is lower than or equal to the output undervoltage warning/Fault lim
until the “CLEAR FAULTS” command is sent from the Alarms Details menu. 

Output
Overvoltage

Shows the output overvoltage Fault limit. The green alarm on the left will turn red when th
the output overvoltage warning/Fault limit. The output overvoltage warning limit is lower th
VOUT value is equal to or greater than the overvoltage output warning/Fault limit, the red
“CLEAR FAULTS” command is sent from the Alarms Details menu. 

Input
Undervoltage

Shows the input undervoltage Fault limit. The green alarm on the left will turn red when th
input undervoltage warning/Fault limit. The input undervoltage warning limit is greater tha
VIN value is lower than or equal to the input undervoltage warning/Fault limit, the red alar
FAULTS” command is sent from the Alarms Details menu.

Input
Overvoltage

Shows the input overvoltage Fault limit. The green alarm on the left will turn red when the
input overvoltage warning/Fault limit. The input overvoltage warning limit is lower than the
value is equal to or greater than the input overvoltage warning/Fault limit, the red alarm tu
FAULTS” command is sent from the Alarms Details menu.

ote 1: An extra byte. after the standard number of bytes specified by the command. is considered a PEC byte.
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b) is ‘1’, the converter is enabled; otherwise, 

lly disabled and can be enabled using the 

 off with the delay set in the Advanced Settings 

accepts the ON/OFF operation.

PEC) byte.(1) This check box is used to 

n checked, the log is written in the “LOG” text 
 and Developer).

F button to stop the board from switching.

the PMBus devices process has finished.
OPERATION OPERATION This box is filled in with the operation command value. If the Most Significant bit (MS
the converter is disabled.

ON_OFF_CONFIG This box is filled in with the ON_OFF_CONFIG command value. The converter is initia
operation PMBus command.

OFF mode This drop-down menu allows the user to choose whether the converter will be turned
menu or with no delay.

ON/OFF These buttons are used to enable/disable the converter. 

Accept operation 
ON/OFF

This button is used to modify the ON_OFF_CONFIG value so that the PMBus device 

Use PEC The PMBus stack supports communication with or without a Packet Error Checking (
communicate the supporting PEC byte.

StoreALL This button stores the values in the Flash (nonvolatile) memory.

Verbose Log This check box is used to activate or deactivate the log from the “LOG” text box. Whe
box for all the menus (including Status, Basic Settings, Advanced Settings, Statistics

RestoreALL This button restores values from the Flash memory. Before restoring, press the OF

Progress Bar The progress bar completes after scanning for the PMBus devices process or when 

TABLE 3-5: STATUS MENU ITEMS (CONTINUED)

Panel Item Description

Note 1: An extra byte. after the standard number of bytes specified by the command. is considered a PEC byte.



Graphical User Interface Description
3.2.7 Basic Settings Menu

The Basic Settings menu allows changing the VOUT value, the output undervoltage 
threshold and output overvoltage threshold warning/Fault limit, the input undervoltage 
and input overvoltage warning/Fault limit, and the overtemperature threshold. The 
overcurrent threshold warning/Fault limit and VOUTmax value cannot be changed.

FIGURE 3-6: The Basic Settings Menu.

The items found in the Basic Settings menu are shown in Table 3-6.
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TABLE 3-6: BASIC SETTINGS MENU ITEMS

Panel Item Description

OUTPUT VOUT Shows the last updated value sent on the PMBus™ to the 
device.

VOUTmax Shows the maximum output voltage value.

Output Undervoltage
Threshold(1)

Shows the output undervoltage limit value.

Output Overvoltage Threshold(1) Shows the output overvoltage limit value.

Overcurrent Threshold(1) Shows the overcurrent limit value.

Overtemperature Threshold(1) Shows the overtemperature limit value.

FAULT(2) Shows the corresponding Fault limit value for the output 
undervoltage/output overvoltage/overcurrent/overtemperature.

WARN(2) Shows the corresponding warning limit value for the output 
undervoltage/output overvoltage/overcurrent/overtemperature.

C/F These radio buttons allow choosing the type of degrees used to 
display the temperature: Celsius or Fahrenheit.

Send This button is used to send the above parameters to the PMBus.

INPUT 
THRESHOLDS

Input Undervoltage Shows the input undervoltage limit value.

Input Overvoltage Shows the input overvoltage limit value.

FAULT(2) Shows the corresponding Fault limit value for the input 
undervoltage/input overvoltage.

WARN(2) Shows the corresponding warning limit value for the input 
undervoltage/input overvoltage.

Send This button is used to send the above parameters to the PMBus.

Note 1: For the overvoltage, overcurrent and overtemperature thresholds, the FAULT value must be greater than 
the WARN value. For the undervoltage threshold, the FAULT value must be smaller than the WARN value.

2: Usually, the FAULT and WARN values for one threshold must be changed simultaneously. If one threshold 
remains unchanged, it could raise unexpected alarms.
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3.2.8 Advanced Settings Menu

The Advanced Settings menu is used to change the maximum output voltage 
(VOUTmax), the output voltage related parameters (POWER_GOOD_ON, 
POWER_GOOD_OFF, TON_RISE, TOFF_FALL) and the switching frequency 
(SWITCHING_FREQUENCY).

FIGURE 3-7: The Advanced Settings Menu.

The items found in the Advanced Settings menu are shown in Table 3-7.

WARNING

Use caution when changing certain parameters, such as SWITCHING_FREQUENCY, because it may 
affect the hardware functionality. Make sure a correct value is filled in as there is no verification 
mechanism. 
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TABLE 3-7: ADVANCED SETTINGS MENU ITEMS

Panel Item Description

ADVANCED VOUTmax Shows the maximum output voltage value in Volts.

IOUTmax Shows the overcurrent Fault limit in Amperes.

PMBusAddress Shows the address of the PMBus™ protocol-enabled device.

Send This button is used to send the information set in the ADVANCED 
panel to the PMBus.

VOUT POWER_GOOD_ON Sets the output voltage at which an optional POWER_GOOD signal 
should be asserted.

POWER_GOOD_OFF Sets the output voltage at which an optional POWER_GOOD signal 
should be negated.

TON_RISE Represents the turn-on delay of the converter in milliseconds.

TOFF_FALL Represents the turn-off delay of the converter in milliseconds.

Send This button is used to send the information set in the “VOUT” group 
box to the PMBus.

FREQUENCY(1) SWITCHING_FREQUENCY Shows the switching frequency value in kHz.

Send This button is used to send the information set in the “FREQUENCY” 
group box to the PMBus.

Note 1: Depending on the revision of the board, the “FREQUENCY” group box will not be included in the 
Advanced Settings menu.
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3.2.9 Statistics Menu

The Statistics menu provides an overview of the output voltage (VOUT), input voltage 
(VIN), output current (IOUT) and temperature (TEMP) values over time.

FIGURE 3-8: The Statistics Menu.

The items found in the Statistics menu are shown in Table 3-8.

TABLE 3-8: STATISTICS MENU ITEMS

Item Description

Coordinate1 Use this selection box to choose the characteristic to monitor: VOUT, VIN, IOUT, TEMP.

Clear Use this button to clear the graph.

Save Use this button to save the current image of the graph.

Start Use this button to start monitoring the chosen characteristic and to start generating the graph.

Stop Use this button to stop scrolling the graph and to stop generating the graph.

Graph Area This area displays the graph created while monitoring the chosen characteristic.
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3.2.10 Alarms Details Menu

The Alarms Details menu presents the following status indicators: STATUS_WORD, 
STATUS_VOUT, STATUS_IOUT, STATUS_INPUT, STATUS_TEMPERAURE, 
STATUS_CML. Green means the corresponding parameters function properly, while 
red means a warning, a Fault or an error has occurred.

FIGURE 3-9: The Alarms Details Menu.

The items found in the Alarms Details menu are shown in Table 3-9.

TABLE 3-9: ALARMS DETAILS MENU ITEMS

Item Description

STATUS_WORD Combines all other status indicators and resumes Faults and warnings.

STATUS_VOUT Displays warnings, Faults and other errors regarding the output voltage values.

STATUS_IOUT Displays warnings, Faults and other errors regarding the output current.

STATUS_INPUT Displays warnings, Faults and other errors regarding the input characteristics.

STATUS_TEMPERATURE Displays warnings and Faults regarding temperature.

STATUS_CML Displays warnings, Faults and other errors regarding communication.

READ FAULTS Reads and updates/refreshes the alarms.

CLEAR FAULTS Clears all these indicators and turns them to green.
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3.2.11 About Menu

The About menu includes the PMBMonitor version number.

FIGURE 3-10: The About Menu.

3.2.12 Help Menu

The Help menu opens the current user’s guide in PDF format.
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3.2.13 Developer Menu

The Developer menu consists of two tabs: Settings and Calibration.

3.2.13.1 SETTINGS TAB

The Settings tab allows changing some manufacturer compensation values and 
setting the overcurrent limit.

FIGURE 3-11: The Settings Tab.

The items found in the Settings tab are shown in Table 3-10.

WARNING

Check the values before clicking on the Send button; new values can affect hardware functionality. Make sure to 
read and understand the hardware specifics. The Settings tab is available only for Microchip devices. This step 
uses only custom commands, manufacturer-specific, and these commands are functional with the specific 
Microchip firmware. For more information, read the material listed under Recommended Reading.
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TABLE 3-10: SETTINGS TAB ITEMS

Group Box Item Description

MANUFACTURER SPECIFIC_OCCON This register controls the voltage drop across the high-side MOSFET 
to determine when an output overcurrent exists.

SPECIFIC_CSGSCON This register controls the amount of gain amplified by the current 
sense AC gain circuitry.

SPECIFIC_CSDGCON This register controls the amount of DC gain added to the sensed 
inductor current to allow it to be read.

SPECIFIC_CMPZCON This register is used to adjust the compensation zero frequency and 
gain.

SPECIFIC_SLPCRCON This register controls the amount of slope added to the error amplifier 
output signal before it is compared to the current sense signal.

SPECIFIC_DEADCON This register controls the adjustment of the driver dead time.

MFR_REVISON Shows the revision of the PMBus™ protocol-enabled device.

Send Use this button to send the specific commands to the PMBus.

IOUT_OC WARNING Shows the overcurrent warning limit value. The value in Volts comes 
from the ADC.

to A These buttons transform the voltage in the overcurrent warning/Fault 
value from Volts (coming from ADC) to the corresponding values in 
Amperes using the specific compensation equation.

FAULT Shows the overcurrent Fault limit value. The value in Volts comes 
from the ADC.

Send Use this button to send the overcurrent warning and Fault limit to the 
PMBus.
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3.2.13.2 CALIBRATION TAB

The Calibration tab allows calibrating the reading/settings of the output voltage and 
the output current.

FIGURE 3-12: The Calibration Tab – Firmware Version 668.

The items found in the Calibration tab are shown in Table 3-11.
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For the 667 and 668 firmware revisions, “ADC(T0)” replaces the “Coefficient-X2” field, 
and the last two lines from the “Current” and “Voltage” columns are disabled. 
Calibration will be done only in two points, taking into consideration the temperature.

For the 666 revision, “ADC(T0)” is replaced by “Coefficient-X2”.

TABLE 3-11: CALIBRATION TAB ITEMS

Group Box Item Description

VOUT Read Shows the output voltage value read from the PMBus™ in Volts.

Measured Shows the measured output voltage value in Volts.

VREF Shows the reference for ADC.

Coefficient Represents the correction to the VOUT value.

Read Use this button to read the VOUT “Read” value.

Send Use this button to send the correction coefficient to the PMBus.

IOUT IOUT Channel Sets the internal or external channel to measure the output current.

Change Use this button to change the output current channel to external or internal.

Current This column contains the selected output current values the voltage will be read for.

Voltage This column contains the voltage read for the specified output current value.

Read Use this button to read the voltage for the specified output current, to be filled in the 
“Voltage” column.

Coefficient-X2(1) Shows the first coefficient of the correction equation.

ADC(T0)(1) Indicates ADC units that represent the initial temperature (T0).

Coefficient-X1 Shows the second coefficient of the correction equation.

Coefficient-X0 Shows the third coefficient of the correction equation.

Calculate Use this button to calculate the correction coefficients for the output current.

Send Use this button to send the correction coefficients for the output current to the PMBus.

ALPHA This parameter represents the temperature variation coefficient.

Note 1: When ADC(T0) is present, the Coefficient-X2 label is not present. In fact, ADC(T0) appears instead of 
Coefficient-X2 and Coefficient-X2 appears instead of ADC(T0), depending on the firmware version.

WARNING

The calibration is hardware-specific and is related to Microchip devices. Do not calibrate unless you 
carefully read the documentation. 
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NOTES:
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Chapter 4.  Using the PMBus Graphical User Interface
To perform the communication between the board and the PC, follow these steps:

1. Connect the board to the PC, using either a PICkit™ Serial Analyzer to be 
connected to the I2C connector, or the MCP2221 Breakout Module. The 
connector is automatically detected by the interface. The board connected to the 
PC may already include the MCP2221 Breakout Module. For these devices, just 
plug the USB cable into the USB connector.

2. Select the “400” option from the Rate drop-down menu. If the “Connector” field 
shows “PICkitSA”, also select the “5” option from the Voltage drop-down menu 
and the “enabled” option from the Pullups drop-down menu.

FIGURE 4-1: Connection Bar.

3. Press on the ScanAddr button. If the board is connected, the address will be 
shown in the Addr drop-down menu. If there are several addresses, manually 
select the correct address of the board from the list of available addresses 
(0x55 for the MCP19111 board). Then, press the Connect button for the 
communication to start running.

WARNING

Make sure you are familiar with the PMBus™ protocol before starting to use the GUI.
If this is the first use of the board, a compensation/calibration procedure might be required. Severe 
malfunction of the board can occur if these steps are skipped. Read the board user guide before starting 
to use the GUI.

Select “5” Select “400” Select 
“enabled”

Note: If “PICkitSA” is selected in the Connector drop-down menu, do not press 
on the ScanAddr button several times in a row. Unplug and replug the 
PICKit Serial Analyzer, then press the ScanAddr button. 

The same behavior occurs on pressing the Disconnect button, followed 
by pressing the Connect button. If “PICKitSA” is selected, unplug and 
then plug the connector again after pressing the Disconnect button, and 
before pressing the Connect button.

No restrictions apply if MCP222X is selected in the Connector drop-down 
menu.
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4. In the Status menu, under the OPERATION panel, press the ON button to enable 
the converter. If the converter does not start and an alarm is triggered (the red 
button on the left of a threshold), check the Alarms Details menu, identify and 
solve the issues before retrying to start the converter. To enable the converter, it 
might be necessary to set the output voltage in the Basic Settings menu to a 
greater or lower value. If the output overvoltage, undervoltage or overcurrent 
Fault limit has been reached, the converter turns off automatically and it can be 
powered on again only after the alarms triggered have been resolved.

FIGURE 4-2: Status Menu – OPERATION Panel.

5. From the drop-down menu, set the “OFF mode” parameter to turn off the 
converter with or without delay. If the “delay” option is chosen, the converter will 
stop with a TOFF_FALL delay, set in the Advanced Settings menu.

6. Depending on the user’s preferences, the following options can be selected:

- Choose between the C and F radio buttons for the temperature to be 
displayed in either Celsius or Fahrenheit degrees.

- Select the “Use PEC” check box if the communication must support the 
PEC byte.

Press the ON Button to 
Enable the Converter

Set Value to
delay/no delay
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7. To close the communication between the GUI and the board, press the 
Disconnect button from the Connection bar, then resume from Step 1.

FIGURE 4-3: Status Menu – PICkit™ Serial Analyzer Connected.

Note: If “PICkitSA” is selected in the Connector drop-down menu, a label with the 
PICkit Serial Analyzer firmware version will be displayed under the 
RestoreALL button, as shown in Figure 4-3.
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8. In the Basic Settings menu, press the Send button in the OUTPUT panel to write 
the commands (values) included on the PMBus stack. Then, the values of the 
parameters for all the thresholds will be replaced with the values entered in the 
text boxes. The value from the “VOUT” box is the voltage set or the value that 
was sent via the PMBus stack on the last update. If VOUT has never been 
changed, the default value will be displayed in the “VOUT” box.

FIGURE 4-4: Basic Settings Menu – OUTPUT Panel.

9. Press Send in the INPUT THRESHOLDS panel to write the commands (values) 
included in this panel on the PMBus stack.

FIGURE 4-5: Basic Settings Menu – INPUT THRESHOLDS Panel.

10. In the Advanced Settings menu, change any parameter, as applicable, and click 
the Send button from the corresponding panel with the changed data.

11. In the Statistics menu (Figure 4-6), select one of the options in the “Coordinate1” 
selection box to display the corresponding graph. The following options are 
available:

- When clicking the Start button, the time coordinate will be displayed on the 
X axis in seconds and the selected coordinate will be displayed on the Y 
axis using the corresponding measurement unit.

- Clicking the Save button will allow capturing the current image of the graph.

- Clicking the Stop or Clear button will allow selecting another coordinate for 
generating the graph.

Press Send to Write 
Commands

Values will Update 
According to the 
Settings

Note: The Start button will be disabled until the Stop or Clear buttons are pressed.

Note: While the graph is generated, the Read buttons from the Calibration tab in 
the Developer menu are disabled. Click the Stop or Clear button to stop 
scrolling the graph and to enable the Read buttons in the Calibration tab.
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FIGURE 4-6: Statistics Menu.

12. Check the Alarms Details menu to see if the green icon on the left of each bit has 
turned red. The red icon indicates that a warning, a Fault or an error has 
occurred. If the icon on the left of any bit is red, identify and solve the cause of 
the alarm.

13. Go to the Settings tab in the Developer menu. Under the MANUFACTURER 
panel, set the specific values (SPECIFIC_OCCON, SPECIFIC_CSGSCON, 
SPECIFIC_CSDGCON, SPECIFIC_CMPZCON, SPECIFIC_SLPCRCON, 
SPECIFIC_DEADCON).

Click Send to transmit these values to the PMBus.

FIGURE 4-7: Settings Tab – MANUFACTURER Panel.

WARNING

It is recommended to read the “MCP19110/11 Data Sheet” (DS20002331) and the 
“TB3139, MCP19111 PMBus™ Firmware Technical Brief” (DS90003139) before changing 
any values in the MANUFACTURER panel.
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14. Before setting the overcurrent warning and Fault values, go to the Calibration 
tab and type the current values in the Current column in the IOUT panel. Perform 
the following tasks:

- Click the Read button corresponding to the current value for which the 
measurement has been performed.

- Set all points for IOUT calibration, then click on the Calculate button.

- Click the Send button at the bottom of the IOUT panel to transmit the 
values to the PMBus.

FIGURE 4-8: Calibration Tab – IOUT Panel.

For a better understanding and usage of calibration procedure, refer to the 
“MCP19111 PMBus™ Protocol-Enabled Point-of-Load (POL) Converter 
Reference Design User’s Guide” (DS50002379) document.

15. To set the overcurrent warning limit and Fault, return to the Settings tab and type 
the current values in the WARNING and FAULT fields corresponding to the Volt 
values in the IOUT_OC panel. Click the to A button to have a value on the left 
field in Volts, filled in by the user, and a calculated value in the right field in 
Amperes.

Click the Send button in the IOUT_OC panel to transmit the values to the PMBus.

FIGURE 4-9: Settings Tab – IOUT_OC Panel.

Click Send to 
Transmit Data 
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16. Go to the Calibration tab under the Developer menu to calibrate VOUT. Perform 
the following tasks:

- Click the Read button in the VOUT panel.

- Measure the real VOUT and type the value in the “Measured” field.

- Click the Send button in the VOUT panel to write calibration values for VOUT.

FIGURE 4-10: Calibration Tab – VOUT Panel.

17. The device calibration is now complete. Click the StoreALL button in the Status 
menu to retain the values after the device has been powered off, or on the 
RestoreALL button to return to the default values.

18. Disconnect the board from the PC to end the communication.

Measured
Value
Input Field

Sends Data to 
Board

Reads VOUT
from the Board

Note: For the 667 and 668 firmware revision boards, the current can be calibrated 
only in two points, and taken into consideration a temperature coefficient 
instead of a second-order coefficient, and four calibration points for the 666 
firmware revision. The procedure is basically the same as above, except 
that it is necessary to wait for the temperature equilibrium to be reached.
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